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1. General information and applicable regulations
In order to guarantee proper functioning of the infrared heating and operation of the system, please observe the following information.
The SUNNYHEAT infrared heating is delivered with this document. Please read the appropriate data sheet chapter carefully before each
work step and ensure that the described procedure is followed precisely.

1.1 General information

For reasons of clarity, this data sheet does not contain all the detailed information about all the types of products and also cannot take
into consideration every possible eventuality during the installation, operation or maintenance. If you would like further information or
if particular problems occur, which are not covered in this data sheet, you can request the necessary information through your supplier.
Further, we would like to indicate that the content of this data sheet is neither part of nor should it alter an existing agreement,
assurance or legal relationship. All the obligations of the supplier arise from the respective purchase contract, which also includes the
complete and solely valid warranty clause. The contractual warranty regulations are neither extended or restricted by use of this data
sheet.

1.2 Applicable regulations

The installed load of the infrared heating, apparent on the name plate, must be observed. The respective locally valid mounting and
installation requirements, guidelines and regulations must be upheld.
•
•
•

The VDE Guidelines and Regulations, e.g. DIN VDE 0100, DIN VDE 0632, the IEC Regulations
The directives and regulations of the professional association, e.g. the Accident Prevention Regulation for electrical installations
and equipment BGV A2 (previously VBG4)
The infrared heating is set to a radiation temperature of 120 °C in the factory. If the infrared heating is attached higher than 180 cm
(dimension applies to the lowest point of the infrared heater), the radiation temperature may be adjusted up to 180 °C. Infrared
heatings with motive are limited to a temperature of 95 °C in the electronics

1.3 Intended purpose

The infrared heating was developed as room heating for the private and commercial sectors. When using the appliance for purposes
other than those in this data sheet, approval by the manufacturer must be sought.

1.4 Safety instructions

•

•
•

The surface of the infrared heating can reach a temperature of up to 180 °C. It is important to ensure that flammable objects have
a distance of at least 50 cm. Flammable materials must have a minimum distance of 100 cm!
Supervise children to avoid them from playing with the SUNNYHEAT infrared heatings!
Do not touch the heating surface of the infrared heating during operation!
Attention! Some parts of this product can become very hot and cause burns. Particular attention has to be given where children
and vulnerable people are present!
Always supervise children under 3 years of age near the heater!
Due to heat generation, do not install the heater directly below a socket!

•

The surface must not even be partially covered to prevent heat accumulation or overheating!

•
•
•
•
•

Dangerous voltage! Opening the infrared heating is not allowed!
Do not use the SUNNYHEAT products in the immediate surroundings of a bath, a shower or a swimming pool!
Never immerse the SUNNYHEAT products or the power cable into water!
Operate and connect the SUNNYHEAT products only in accordance with the specifications on the nameplate!
Use the SUNNYHEAT products only if power cables and devices are not damaged! Remove the plug of the infrared heating in case
of fault!
Do not use the SUNNYHEAT products in potentially explosive environments!
The SUNNYHEAT products are designed for use in enclosed, dry rooms with a temperature range of –10.0 °C to +50.0°C!
Persons (including children) with reduced physical sensory perception abilities or mental capabilities, or lack of experience and
knowledge, should not be allowed to use SUNNYHEAT products, unless they are supervised or have been given instructions with
regard to the use of SUNNYHEAT products, by a person who is responsible for their safety

•
•
•

•
•
•
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•
•
•

•

Repairs to the SUNNYHEAT products, such as replacing a damaged cable, may only be performed by SUNNYHEAT specialist dealers
or the manufacturer
Children must not clean/operate/maintain the SUNNYHEAT product without supervision by persons responsible for their safety!
Children aged from 3 years and less than 8 years shall only switch on/off the appliance provided that it has been placed or installed
in its intended normal operating position and they have been given supervision or instruction concerning use of the appliance in
a safe way and understand the hazards involved. Children aged from 3 years and less than 8 years shall not plug in, regulate and
clean the appliance or perform user maintenance!
Only transport, install, dismantle and clean the infrared heater when it has cooled down and is switched off! Clean the glass of the
heater only with a dry or slightly damp cloth!

1.5 Disposal

After use, the infrared heater must be disposed of or recycled in accordance with legal requirements. The symbol of a
crossed out dustbin indicates that the product is subject to the European Directive 2002/96/EC and, as within all waste
electrical and electronic appliances, must be separated from the general household waste and disposed of in the facilities
provided by the local authorities. By disposing of the old appliances properly, you avoid causing damage to the
environment and risk to personal health. Further information regarding disposal of the old appliances is available from
the local council or department of waste disposal. WEEE-Number: DE 36476097

1.6 Liability

We are not liable for object/property damage or personal injury arising from the inappropriate installation caused by failure to comply
within the permissible operation and/ or the safty construction as well as spontaneous breakage of glass.
No liability is accepted for the inappropriate use, inappropriate fitting, installation and the use of non-original accessories! Equally, the
manufacturer can refuse the warranty for damage to the product caused by disregard of the product information given in this data
sheet, use other than the intends purpose or inappropriate use. Liability for the consequential injuries to persons or property is in this
case also excluded.
The liability does not extend to parts, materials or other items of equipment that have been manufactured by the customer or on his
order and then have been made provided to the manufacturer. The customer must check the quality, suitability and load capacity, as
well as heat resistance of the mounting substrate and surrounding materials independently and select a suitable mounting. No liability
is assumed for damages are due to an incorrect selection by the customer.

1.7 Guarantee conditions
•
•
•
•

•

•
•
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When registering a guarantee claim, the customer must present the original invoice or the receipt from the supplier, or
corresponding confirmation of purchase. The serial number of the product must be legible.
Whether the guarantee is fulfilled by repair or exchange of the product or defective part is at the discretion of CREA SYSTEMS. The
original guarantee period will not be extended following repair or the exchange of parts. Further claims are excluded.
Guarantee repairs must be performed by SUNNYHEAT stockiest or SUNNYHEAT contractors. For repairs performed by other dealers,
no claims for reimbursement will be accepted, for example repairs and damage, which could thereby be caused to the product, are
not covered by this guarantee.
Should the product be used in a country other than that for which it was originally developed and produced, alterations to the
product must possibly be made in order to ensure it conforms to the technical and/or safety standards of the other country. Such
alterations are not due to faults in the product materials or workmanships and are not covered by guarantee. The costs for such
alterations and for any resulting damage to the appliance will not be reimbursed.
The exceptions to the guarantee cover are:
• Damage caused by incorrect installation or covering of the heating surface
• Transport and travel costs, and the costs arising from the assembly and dismantling of the product
• Abuse and misuse of the product, as well as incorrect installation
• SUNNYHEAT products with a damaged or broken seal
• Damage caused by lightening, water, fire, force majeure, war, incorrect supply voltage, insufficient air circulation or other
means for which CREA SYSTEMS/SUNNYHEAT is not responsible
• Damage caused by failure to comply with technical instructions and / or safety information, as well as spontaneous breakage of
glass
This guarantee is bound to a specific product and, within the guarantee period, a claim can be made by any person who has
acquired the appliance legally.
The right of the buyer according to the product national legislation, i.e. the rights of the buyer associated the purchase agreement
opposed to those of the supplier, as well as other rights, are not infringed upon by this guarantee. In so far as the national
legislation makes no other provision, the claims of the buyer are limited to the points named in this guarantee.

Guarantee process for the SUNNYHEAT
This SUNNYHEAT product has a manufacturer‘s guarantee of 10 years on the mechanical parts and the electrical infrared heating
system, and 2 years on the electronic parts (infrared heater, electronics, thermostat, sensors) or for commercial use, covering defects
in the materials and workmanship. The guarantee period begins with the purchase of the appliance at the CREA SYSTEMS Electronic
GmbH. Should it be necessary to claim on the warranty, please contact your stockist, from whom you purchased the appliance. Unpaid
returns will not be accepted under any circumstances. The means of shipment, etc. must be agreed with CREA SYSTEMS. Claims
for guarantee services can also be made at SUNNYHEAT contractors in other countries. In doing so, the guarantee condition of the
corresponding country apply.
The terms and conditions of CREA SYSTEMS apply: www.crea-systems.de/agb.

2. Infrared heating
2.1 Electric installation

Before installation ensure that the infrared heating is switched off at the electronics and the plug has been removed from the mains
power. Connect the enclosed plug on the back of the infrared heating to the electronics. You can identify the appropriate connector for
the plug, due to the 230 V label. There is a clicking sound when the plug is properly engaged. Only if the click sound could be heard, a
proper power supply is guaranteed. After the power plug has been connected to the electronics, insert the other end of the power plug
into the socket. A safety (Schuko) socket is required for connection and operation.
For fixed installations, according to overvoltage category III for complete isolation, an independent separator must be provided for
emergencies, such as a switch or a fuse. Furthermore, the requirements of the local electricity provider and the relevant, countryspecific safety and installation regulations must be observed.
If it is observed that safe operation is not possible, the infrared heater must be either not put into operation or taken out of operation.
This assumption is valid when:
• The infrared heating or the supply line show signs of damage
• The product is no longer working as intended
Should work on the 230 V netzwork be necessary, this should only be performed by a suitably qualified electician (according to DIN VDE
0100). According to DIN VDE 0022, the operator and the installer are responsible for ensuring compliance with the power provider and
DIN VDE requirements.

2.2 Information regarding the electrical connection

The infrared heating fulfils the rquirements for interference immunity and interference emission for use in residential and commercial
areas.

2.3 Maintenance

Inside the product there are no user-serviceable parts.

2.4 Fitting

Please note: The infrared heating are composed of a glass pane. Do not place frameless infrared heaters on the corners. Please handle
with appropriate care and check if it has proper mounting surface! You are responsible for checking the quality, suitability and loadbearing capacity of the installation substructure and selecting suitable fixing materials!
•
•
•

In the case of recessed ceiling mounting, a circumferential ventilation slot at least 2 cm wide must be maintained on all four sides
of the infrared heater. The on/off switch must be operable.
For ceiling mounting, a distance of at least 2 cm from the nearest wall must be maintained. In the case of sensitive surfaces, larger
distances may be necessary.
A distance of at least 10 cm must be maintained between infrared heaters mounted next to each other.

The SUNNYHEAT infrared heating can be mounted to the wall or ceiling. First the four mounting holes are drilled following the drilling
plan, sink the wall plugs into the wall and turn the screws until 1 cm remains showing, so that the infrared heater can be hung Ensure
that the screws are sufficiently secured! Keep in mind that the position of the infrared heater shifts by about 15 mm during locking. If
possible, please use the respective mounting set!
Dangerous voltage! Opening the product is not necessary. Do not install when it is in operation! The guarantee is invalidated if
the seal is damaged!
Please check which mounting variant your infrared heating has and follow the steps for fixing that variant.
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2.4.1 Fitting variant 1
Drill hole diameter for enclosed wall plug: 8 mm, drill hole length min. 50 mm.
Drilling

y
x

Format

Drilling X

Drilling Y

60 x 60

45 cm

51 cm

60 x 90

75 cm

51 cm

60 x 120

105 cm

51 cm

30 x 30

15 cm

21 cm

30 x 60

45 cm

21 cm

30 x 90

75 cm

21 cm

30 x 120

105 cm

21 cm

30 x 150

135 cm

21 cm

Bring suitable screws and dowels according to the drilling dimensions . Turn the lock tabs into the open position,
mount the infrared heating and push in the direction of the arrows to the stop.

Finally, move the lock tabs into the secure position.

2.4.2 Fitting variant 2
Drill hole diameter for enclosed wall plug: 8 mm, drill hole length min. 50 mm.
Drilling

y
x

Format

Drilling X

Drilling Y

60 x 60

42.1 cm

44 cm

60 x 90

40 cm

44 cm

60 x 120

70 cm

44 cm

60 x 150

100 cm

44 cm

30 x 90

70 cm

14 cm

30 x 120

100 cm

14 cm

30 x 150

100 cm

14 cm

Bring suitable screws and dowels according to the drilling dimensions of the mounting surface, then hang the
infrared heating with the attachment. For this press the attachment to the panel centered over the screw
head.

Align the infrared heating in the attachment as desired. Ensure that the screw is no longer in the middle but is
snapped sideways into one of the openings.

Carefully check that the infrared heating can no longer slip out from the mounting! Only let the panel release
when this is secured.

2.5 First commissioning

After completion of the assembly and electrical installation, the infrared heater is ready. During initial heating unpleasant odors can
occur, but these disappear after the first 3-4 heating processes. Ensure good ventilation during heating. Prevent odours being drawn
into other rooms.

2.6 Control

The infrared heating system SUNNYHEAT possesses an intelligent control system, which supplies the room with always enough heating
power as is necessary to reach an maintain the pre-set room temperature. Together with the remote thermostat,ECOcontrol, huge
amounts of energy can be saved, as overheating of the room is avoided. This also means that even the large infrared heating with up to
22

2500 W does not require more energy to heat a small room than the smallest infrared heating with only 250 W capacity.
The infrared heating automatically down-regulates the heating capacity, when it is not required, so that greater energy saving is
possible. The intelligent control programs can maintain a stable temperature to 0.1°C without overshooting of conventional regulators.
In addition, the heating capacity is graduated from 0—100 %, which corresponds to 25 W in a large infrared heater with 2500 W. Thus,
efficient energy saving is always guaranteed and the choice of the infrared heating size is non-critical. The heating power is switched off
completely when ECOcontrol determines that the room temperature no longer decreases or that the setpoint temperature has been
exceeded.
With the heating capacity setting the infrared heating is provided the maximum heating capacity so that the room heats up quickly.
It usually does not lead to increased energy costs. By doing this, the room reaches the desired temperature earlier, and the infrared
heating can reduce the heating power (to maintain the room temperature). Should a room require several infrared heating, then
regulation can take place using a single ECOcontrol.

2.7 Heating types
Typ

Weight

Room size

Dimensions

Voltage

Power

Remote receiver

SH-60601/2*

8.6 kg

until 15 m²**

60 x 60 cm

230 V / 50 Hz

1000 W / 4.4 A

915 MHz

SH-60901/2*

12.1 kg

until 20 m²**

60 x 90 cm

230 V / 50 Hz

1500 W / 6.6 A

915 MHz

SH-601201/2*

15.6 kg

until 25 m²**

60 x 120 cm

230 V / 50 Hz

2000 W / 8.8 A

915 MHz

SH-601501/2*

19.1 kg

until 30 m²**

60 x 150 cm

230 V / 50 Hz

2500 W / 10.9 A

SH-30301*

2.5 kg

until 3,5 m²**

30 x 30 cm

230 V / 50 Hz

250 W / 1.1 A

915 MHz
915 MHz

SH-30601*

5.2 kg

until 7 m²**

30 x 60 cm

230 V / 50 Hz

500 W / 2.2 A

SH-30901/2*

6.9 kg

until 10 m²**

30 x 90 cm

230 V / 50 Hz

750 W / 3.3 A

915 MHz
915 MHz

SH-30121/2*

8.7 kg

until 15 m²**

30 x 120 cm

230 V / 50 Hz

1000 W / 4.4 A

915 MHz

SH-301501/2*

10.5 kg

until 18 m²**

30 x 150 cm

230 V / 50 Hz

1250 W / 5.5 A

915 MHz

Surface temperature: Setting via ECOcontrol from 0 - 180°C, by Industry heaters and HotSports heaters: 0 - 215°C (electronically
regulated)
Safety temperature limiting: Over temperature guard
Remote range: Approx. 20 m within a closed room with not interior walls
Supply voltage: U~ = 205 - 240V
Protection: IP20
Standby consumption: < 0,5 W
* 1 = with frame / 2 = frameless
**Please note that the details regarding the sizes of the room to be heated can differ greatly. This is essentially dependent upon the
condition of the walls. While making our recommendation, we have assumed the latest DIN-specification for house isolation. If an
above averange energy consumption is observed during the heating of a room, then additional infrared heaters should be considered.

3. Sensors
3.1 Motion sensor

The motion sensor detects whether someone is located inside the room or not. If no one is located inside the room, SUNNYHEAT
regulates the temperature to a defined setpoint temperature after a defined delay time. If someone is located inside the room,
SUNNYHEAT regulates the temperature to the normal setpoint temperature.
3.1.1 Power supply
The motion sensor is supplied with power by the SUNNYHEAT infrared heater.
3.1.2 Installation
•
•

•
•

Unplug the infrared heater or switch off the infrared heater on the rear side
of the electronics.
The motion sensor is attached to the electronics of the infrared heater
below the switch. Insert the plug of the motion sensor into one of the
two rows of 3 pins so that the protrusion points towards the switch (see
illustration).
Insert the plug of the infrared heater into the socket or switch on the
infrared heater via the electronics.
The functioning of the motion sensor can be tested by activating the motion
sensor with ECOcontrol (see 3.7.1.1) and moving. You should see on the
main display.
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3.2 Window sensor

The window sensor detects whether a window is open or closed. If the window is open, SUNNYHEAT regulates the temperature to a
specified setpoint temperature. If the window is closed, SUNNYHEAT regulates the temperature to the normal setpoint temperature.
Up to 8 window sensors can be connected to an ECOcontrol thermostat.
3.2.1 Delivery content
1 x window sensor with Velcro fastener, 1 x type CR2032 button cell battery, 1 x magnet with adhesive tape, 1 x Velcro fastener with
adhesive tape.
3.2.2 Power supply/battery replacement
The window sensor is powered by a type CR2032 button cell battery.
The battery in the window sensor can be replaced via the rear side of the sensor. Detach the window sensor from the Velcro fastener.
Pull the lid back on the ribbed surface and replace the button cell battery. The plus side of the battery must point upwards.
3.2.3 Installation
•
•
•
•

•

•
Window sensor
Magnet

•
•

Before installation, close the window on which the window sensor is to be
installed.
The magnet is mounted on the window frame. The window sensor is
mounted on the window sash.
First hold the magnet in the desired position on the window frame.
Hold the window sensor on the window sash. Make sure that the window
sensor is aligned longitudinally and that the LED is centred at the height of
the magnet (see illustration). When the window is closed, the magnet and
window sensor must not be more than approx. 1.5 cm apart.
If the window sensor and magnet are at the correct distance from each
other, the LED of the window sensor flashes once. The window was
recognised as closed. If the window sensor is at a distance of more than
approx. 1.5 cm from the magnet, the LED of the window sensor flashes
twice. The window was recognised as open.
Remove the protective film from the adhesive tape of the magnet and
attach the magnet to the window frame.
Remove the protective film from the Velcro fastener and attach it to the
window sash. Attach the window sensor to the window sash with the Velcro
fastener and align it if necessary.
If the window sensor is activated in ECOcontrol (see 4.7.2.1) and connected
(see 4.7.2.3), ECOcontrol shows on the main display when the window is
open and when the window is closed.

Tip: If required, the magnet can be mounted on the window sash; in this case, the window sensor must be mounted on the window
frame. The installation locations of the window sensor and magnet depend on the window type. With double-sash windows, for
example, it is recommended to mount the magnet and window sensor on the sashes.

3.3 Outside temperature sensor

The outside temperature sensor measures the outside temperature. If the outside temperature sensor is activated, SUNNYHEAT only
turns up the heating if the outside temperature is below a specified outside temperature.
3.3.1 Delivery content
1 x outside temperature sensor, 2 x screws, 2 x dowels
3.3.2 Power supply
The outside temperature sensor is connected to a socket with a plug. A 230 V power supply is required.
3.3.3 Installation
• The outside temperature sensor is mounted on the outside of the building with the enclosed screws. Please verify that the
mounting surface is appropriate! The condition and load-bearing capacity of the mounting surface must be verified independently,
and a suitable fastening method must be selected. The outside temperature sensor must not lie on the floor; it must always be
mounted on the wall. If the sensor is left on the floor, there is a risk that water may penetrate the sensor! We recommend an
installation on the north side and under a roof, because otherwise, solar radiation and rain can affect the outside temperature
reading.
• Make sure that the outside temperature sensor is not powered during installation! Pull the plug out of the socket!
• Hold the outside temperature sensor at the desired installation location.
• Fasten the outside temperature sensor with the two screws.
• Supply the outside temperature sensor with power.
• The outside temperature sensor can then be activated as described in point 4.7.3.1. The outside temperature is displayed as
described in point 4.7.3.3. If a minus appears in the Display menu instead of the temperature, the outside temperature sensor is
out of range or it is not working correctly.
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4. ECOcontrol
4.1 Power supply/charging

The ECOcontrol thermostat has a built-in lithium-ion battery. The battery can be charged with the included USB cable. To do this, plug
the USB cable into the slot on the bottom of ECOcontrol. Then insert the plug into the socket. During charging and approx. 2 to 3 hours
afterwards, the actual temperature may rise as the device heats up during charging. If necessary, the setpoint temperature may have to
be adjusted.
If you have purchased an ECOcontrol unit with a 230 V connection, the ECOcontrol unit is connected directly. The battery and charging
cable are then not included.

4.2 Initial startup

Search language -> Select language-> 3 x

4.3 Symbols
Symbol

Meaning

Symbol

Meaning

on/off

confirm

change values

back

operating modes

present/absent

battery full/empty

maximum outside temperature exceeded

setpoint temperature

window open/closed

actual temperature

rapid warm-up

date

frost protection

time

flight mode

up/down

heating schedule

lighting on/off/dim (long press)

child lock

switch off bypass

key lock

menu

holiday

cancel

reception/no reception

send

4.4 Main display

reception

menu

battery

setpoint temperature
actual temperature
date

time

on/off

operating mode

plus

minus

25

4.4.1 On/Off
i ECOcontrol and the SUNNYHEAT infrared heaters are switched on or off.
-> -> Off
-> Press the ECOcontrol display for several seconds -> On
4.4.2 Setpoint temperature
i The setpoint temperature is the desired temperature in a room.
->
->

-> Increase setpoint temperature
-> Decrease setpoint temperature

4.4.3 Operating modes
i The operating mode is configured in this menu. It determines the way in which the SUNNYHEAT infrared heating should work.
Automatic: ECOcontrol regulates the heating power and surface temperature automatically according to the conditions in the room
and according to the setpoint temperature. "Automatic" is the recommended default setting.
Rapid warm-up: The connected infrared heaters heat up for 30 minutes with the configured maximum heating power and the
configured maximum surface temperature without taking the setpoint temperature into account. After the 30 minutes have elapsed,
SUNNYHEAT switches to automatic.
Frost protection: The connected infrared heaters are switched to frost protection mode. The temperature is raised to the configured
setpoint temperature for frost protection. All other functions are ignored. This operating mode is only available if Frost protection has
been activated in the menu.
Flight mode: The connected infrared heaters are switched off. The ECOcontrol display remains on and does not switch itself off.
4.4.3.1 Automatic
->
Search for operating mode -> Automatic ->
4.4.3.2 Rapid warm-up
->
Search for operating mode -> Rapid warm-up ->
4.4.3.3 Frost protection
->
Search for operating mode -> Frost protection ->
4�4�3�4 Flight mode
Search for operating mode ->
Flight mode ->
->

4.5 General
4.5.1 Language
i The ECOcontrol language is configured in this menu.
-> General -> Language ->

Search language -> Select language-> 3 x

4.5.2 Date
i The current date is configured in this menu. The current date is required for certain functions (e.g., holiday).
Format: The display format for the date is configured in this menu.
Date: The actual date is configured in this menu.
Weekday: The current weekday is configured in this menu.
4.5.2.1 Format
-> General -> Date -> Format -> Select format -> 4 x
4.5.2.2 Date
-> General -> Date -> Date -> Select day, month or year ->
Change date ->
Confirm -> 3 x
4.5.2.3 Weekday
-> General -> Date -> Weekday ->
Search for weekday -> Select weekday -> 4 x
4.5.3 Time
i The current time for ECOcontrol is configured in this menu. The time is required for certain functions (e.g., the heating schedule).
-> General -> Time -> Select hours or minutes ->

Change time ->

Confirm -> 2 x

4.5.4 Lighting
i The optional SUNNYHEAT lighting is configured in this menu.
Button: This menu is used for enabling the button that switches the lighting on the main display on or off.
Switching: The lighting is switched directly in this menu.
Dimming: This menu is used to specify whether the lighting is dimmable.
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4.5.4.1 Button
-> General ->
4.5.4.2 Switching
-> General ->
4.5.4.3 Dimming
-> General ->

-> Lighting -> Button -> Select show or hide -> 4 x

->

Lighting On/Off

-> Lighting -> Switching -> Select On or Off -> 4 x
-> Lighting -> Dimming -> Select On or Off -> 4 x

->

Keep button pressed

4.5.5 Standby
i Standby mode is configured in this menu. In standby mode, the ECOcontrol display is switched off. The status LED flashes to indicate
that ECOcontrol is ready for operation.
Signal: This menu is used for configuring the interval for the flashing of ECOcontrol's status LED. If "Never" is selected, the red LED on
the heating electronics is also deactivated with the status LED.
Time: This menu is used for configuring the time after which ECOcontrol switches to standby mode.
Caution! The configured time may have an impact on battery life!
4.5.5.1 Signal
-> General ->
4.5.5.2 Time
-> General ->

-> Standby -> Signal -> Select from 10 seconds, 40 seconds or never -> 4 x
-> Standby -> Time ->

Search for time -> Select from 10 seconds, 30 seconds, 60 seconds or never -> 4 x

4.5.6 Brightness
i The brightness for the ECOcontrol display is configured in this menu.
Caution! The configured brightness may have an impact on battery life!
-> General ->

-> Brightness -> Eco, Select Eco, Normal or Bright -> 3 x

4.5.7 Smart Home
i The network settings for the SUNNYHEAT infrared heaters are configured in this menu. The SUNNYHEAT infrared heaters can be
operated with the SUNNYHEAT app, the Alexa app or via the Alexa Smart Speaker. For this purpose, the infrared heaters must be
connected to your WLAN network. This can be done either in this menu on the ECOcontrol thermostat or via the SUNNYHEAT app.
Activate/Deactivate: This menu is used to configure whether the connected SUNNYHEAT infrared heaters should be available in the
network.
Reset: This menu is used to reset the network settings to the factory settings. It can take up to a minute for a complete reset of the
network.
SSID: The SSID of the network into which the SUNNYHEAT infrared heaters are to be integrated is entered in this menu..
Password: The password for the network (SSID) is entered in this menu.
4.5.7.1 Activate/Deactivate
-> General -> 2 x
-> Smart Home -> Activate/Deactivate -> Select Activate or Deactivate -> 4 x
4.5.7.2 Reset
-> General -> 2 x
-> Smart Home -> Reset ->
Confirm -> 3 x
4.5.7.3 SSID
-> General -> 2 x
-> Smart Home -> SSID -> Select 0-9, A-Z, a-z,
->
Change letters, numbers, special characters ->
Confirm entry -> use < > to switch between views -> Repeat process ->
Confirm -> 3 x
4.5.7.4 Password
-> General -> 2 x
-> Smart Home -> Password -> Select 0-9, A-Z, a-z,
->
Change letters, numbers, special characters ->
Confirm entry -> use < > to switch between views -> Repeat process ->
Confirm -> 3 x
4.5.7.5 Keyboard
Uppercase letters Confirm Lowercase letters
entry
SSID/Password
Entry

Switch view

Numbers

Special characters

Change letters, numbers
and special characters

Confirm SSID/
Password

Back

27

4.5.8 Energy consumption
i This menu is used for displaying and resetting the energy consumption of the connected SUNNYHEAT infrared heaters.
Power: The specified power of all SUNNYHEAT infrared heaters connected to this ECOcontrol is entered in this menu. The power values
can be found on the nameplates of the infrared heaters. If several infrared heaters are connected to ECOcontrol, their power values
must be added. The power is required to correctly display the energy consumption.
Display: This menu displays the energy consumption. If the power was entered in the Power menu, the displayed value is in kWh,
otherwise the service hours are displayed.
Reset: The energy consumption is reset to 0 in this menu.
4.5.8.1 Power
-> General -> 2 x
4.5.8.2 Display
-> General -> 2 x
4.5.8.3 Reset
-> General -> 2 x

-> Energy consumption -> Power ->

Change power ->

Confirm -> 3 x

-> Energy consumption -> Display -> 4 x
-> Energy consumption -> Reset ->

Confirm -> 3 x

4.5.9 Factory settings
i This menu makes it possible to reset ECOcontrol to the factory settings and change the PIN for the factory settings.
Default PIN: 1000.
Reset: In this menu, ECOcontrol and the infrared heaters connected to it are reset to the factory settings. A PIN is required to perform a
reset to the factory settings.
Change PIN: The PIN for performing a reset to the factory settings can be changed in this menu.
Caution! Please make a note of the PIN (e.g., in the User Manual). The PIN for the factory settings can only be reset by the
manufacturer for a fee.
4.5.9.1 Reset
-> General -> 2 x
4.5.9.2 Change PIN
-> General -> 2 x
Confirm -> 3 x

-> Factory settings -> Reset -> Select PIN ->

Change PIN ->

-> Factory settings -> Change PIN -> Select old PIN ->

Confirm ->

Confirm -> 3 x

Change PIN -> Select new PIN ->

Change PIN ->

4.6 Control
4.6.1 Surface temperature
i The surface temperature can be viewed and configured in this menu. The surface temperature is the temperature on the surface of
the SUNNYHEAT infrared heater.
Max. surface temperature: This menu is used to enter the maximum surface temperature that the SUNNYHEAT infrared heater is
allowed to reach.
Display: This menu is used to display the current surface temperature for the surface.
4.6.1.1 Max. surface temperature
-> Control -> Surface temperature -> Max. surface temp. ->
4.6.1.2 Display
-> Control -> Surface temperature -> Display -> 4 x

Change surface temperature ->

Confirm -> 3 x

4.6.2 Heating power
i The heating power can be viewed and configured in this menu. The heating power is the power that is used by the SUNNYHEAT
infrared heater. The heating power is specified in %..
Max. heating power: This menu is used to configure the maximum heating power that SUNNYHEAT is allowed to use to heat up a
room. For example, if a SUNNYHEAT infrared heater has a maximum power of 2,000 watts and the heating power is set to 50%, the
SUNNYHEAT infrared heater will use up to a maximum of 1,000 watts.
Display: This menu is used to display the heating power that is currently being used by SUNNYHEAT.
4.6.2.1 Max. heating power
-> Control -> Heating power -> Max. heating power ->
4.6.2.2 Display
-> Control -> Heating power -> Display -> 4 x
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Change heating power ->

Confirm -> 3 x

4.6.3 Frost protection
Frost protection can be configured in this menu. If frost protection is configured, SUNNYHEAT will not let the room temperature fall
below the setpoint temperature configured for frost protection here. If frost protection is active or the Frost protection operating mode
is selected, is shown on the main display.
Activate/Deactivate: This menu is used to activate or deactivate frost protection. If frost protection is activated, automatic frost
protection is active and Frost protection mode is available.
Setpoint temperature: The setpoint temperature for frost protection is set in this menu. The normal setpoint temperature can no
longer be set to be lower than the setpoint temperature for frost protection.
i

4.6.3.1 Activate/Deactivate
-> Control -> Frost protection -> Activate/Deactivate -> Select Activate or Deactivate -> 4 x
4.6.3.2 Setpoint temperature
-> Control -> Frost protection -> Setpoint temperature ->
Change setpoint temperature ->

Confirm -> 3 x

4.6.4 Heating schedule
i The heating schedule is configured in this menu. The heating schedule is a timetable in which it is specified on which weekday and
how the heating should take place. The modules for each weekday are temperature profiles. A temperature profile consists of the time
from which heating should start and the setpoint temperature which should be reached. 8 temperature profiles can be created per
weekday. If the heating schedule is activated and a temperature profile is active, the main display shows .
Activate/Deactivate: The heating schedule can be activated or deactivated in this menu.
Display: The days of the week for the heating schedule are displayed in this menu.
Temperature profiles: This menu makes it possible to add/edit/remove temperature profiles for a given weekday.
Temperature profiles - Add: Temperature profiles are created in this menu. A temperature profile defines the time from which a certain
setpoint temperature is to be controlled.
Temperaturprofile - Display: In this menu, the created temperature profiles for this weekday are displayed.
Temperaturprofile - Edit: An existing temperature profile is edited in this menu.
Temperaturprofile - Remove: A temperature profile is removed in this menu.
Copy to: In this menu, the temperature profiles for a given weekday are copied to one or more other weekdays. The existing
temperature profiles for these weekdays are overwritten.
Remove: In this menu, all temperature profiles for a given weekday are removed.

4.6.4.1 Activate/Deactivate
-> Control ->
-> Heating schedule -> Activate/Deactivate -> Select Activate or Deactivate -> 4 x
4.6.4.2 Display
-> Control ->
-> Heating schedule -> Display -> 4 x
4.6.4.3 Temperature profiles
-> Control ->
-> Heating schedule -> Display ->
Search for weekday -> Select weekday -> Temperature profiles -> 6 x
4.6.4.4 Temperature profiles - Add
-> Control ->
-> Heating schedule -> Display ->
Search for weekday -> Select weekday -> Temperature profiles -> Add ->
Select time ->
Change time -> Select setpoint temperature ->
Change setpoint temperature ->
Confirm -> 6 x
4.6.4.5 Temperature profiles - Display
-> Control ->
-> Heating schedule -> Display ->
Search for weekday -> Select weekday -> Temperature profiles -> Display
->
Search for temperature profile -> 7 x
4.6.4.6 Temperature profiles - Edit
-> Control ->
-> Heating schedule -> Display ->
Search for weekday -> Select weekday -> Temperature profiles -> Display
->
Search for temperature profile -> Select temperature profile -> Edit -> Select time ->
Change time -> Select setpoint
temperature ->
Change setpoint temperature ->
Confirm -> 7 x
4.6.4.7 Temperature profiles - Remove
-> Control ->
-> Heating schedule -> Display ->
Search for weekday -> Select weekday -> Temperature profiles -> Display
->
Search for temperature profile -> Select temperature profile -> Remove ->
Confirm -> 7 x
4.6.4.8 Copy to
-> Control ->
-> Heating schedule -> Display ->
Search for weekday -> Select weekday -> Copy to ->
Search for
days of the week -> Select days of the week ->
Confirm ->
Confirm -> 4 x
4.6.4.9 Remove
-> Control ->
-> Heating schedule -> Display ->
Search for weekday -> Select weekday -> Remove ->
Confirm -> 5 x
4.6.5 Holiday
i In this menu, ECOconrol is set to Holiday mode. ECOcontrol regulates the temperature to a configured setpoint temperature for a
longer period of time. If Holiday mode is activated and the holiday period has begun, the main display shows .
Activate/Deactivate: This menu is used to activate or deactivate Holiday mode.
Period: The start and end of the Holiday period are set in this menu. In order for the Holiday period to start correctly, the Start date
must be at least one day in the future.
Setpoint temperature: The setpoint temperature for the holiday period can be set in this menu.
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4.6.5.1 Activate/Deactivate
-> Control ->
-> Holiday -> Activate/Deactivate -> Select Activate or Deactivate -> 4 x
4.6.5.2 Period
-> Control ->
-> Holiday -> Period -> Select day, month or year for start ->
Change date -> Select day, month or year for end
->
Change date ->
Confirm -> 3 x
4.6.5.3 Setpoint temperature
-> Control ->
-> Holiday -> Setpoint temperature ->
Change setpoint temperature ->
Confirm -> 3 x
4.6.6 Mode
i This menu is used to configure how the SUNNYHEAT infrared heating should regulate the temperature. SUNNYHEAT works with a PI
controller, which means that SUNNYHEAT repeatedly checks the conditions in the room and adapts the control parameters. In Eco
Mode, the SUNNYHEAT infrared heater controls the temperature more gently and in Normal Mode, this is done a bit more aggressively.
Normal is intended for poorly insulated rooms.
-> Control ->

-> Mode -> Select mode -> 3 x

4.6.7 Timing
This menu is used to set the length of a power cycle for the SUNNYHEAT infrared heating. Normal is the default setting. Fast is
required if the network load of several SUNNYHEAT infrared heaters has to be distributed. A qualified electrician will point this out
during installation. Photovoltaics is required if the electricity consumption is to be monitored by an energy cost meter or a photovoltaic
system.
i

-> Control -> 2 x

-> Timing -> Select timing -> 3 x

4.6.8 Switch off bypass
i This menu is used to configure how any shutdown periods of the grid operator are bridged. Some electricity providers offer special
tariffs for electric heating. Subscribers who utilise such tariffs have an extra electricity meter for the heating current, and the grid
operator reserves the right to switch off the heating current when the load is too high. The switch-off bypass raises the setpoint
temperature before the switch-off periods to make the room warmer. This prevents rapid cooling. If the switch-off bypass is activated
and period 1 or period 2 has started, the main display shows .
Activate/Deactivate: This menu can be used to activate or deactivate the switch off bypass.
Period 1: This menu is used to configure the first period in which the setpoint temperature is to be increased.
Period 2: This menu is used to configure the second period in which the setpoint temperature is to be increased.
Temperature increase: This menu is used to configure the temperature by which the setpoint temperature is to be increased during
switch-off bypass periods.
Max. outside temperature: This menu is used to configure the maximum outside temperature up to which the switch-off bypass is to
become active. If the outside temperature is above this maximum outside temperature, the switch-off bypass is not active. This menu is
taken into account if the outside temperature sensor has been activated.
4.6.8.1 Activate/Deactivate
-> Control -> 2 x
-> Switch off bypass -> Activate/Deactivate -> Select Activate or Deactivate -> 4 x
4.6.8.2 Period 1
-> Control -> 2 x
-> Switch off bypass -> Period 1 -> Select time for start ->
Change time -> Select time for end ->
Change time ->
Confirm -> 3 x
4.6.8.3 Period 2
-> Control -> 2 x
-> Switch off bypass -> Period 2 -> Select time for start ->
Change time -> Select time for end ->
Change time ->
Confirm -> 3 x
4.6.8.4 Temperature increase
-> Control -> 2 x
-> Switch off bypass ->
-> Temperature increate ->
Change temperature ->
Confirm -> 3 x
4.6.8.5 Max. outside temperature
-> Control -> 2 x
-> Switch off bypass ->
-> Max. outside temp. ->
Change temperature ->
Confirm -> 3x

4.7 Sensors
4.7.1 Motion sensor
i The motion sensor is configured in this menu. The motion sensor detects whether someone is located inside the room or not. If no
one is located inside the room, SUNNYHEAT regulates the temperature to a defined setpoint temperature. If someone is located inside
the room, the temperature is regulated to the normal setpoint temperature. If no one is located inside the room, appears on the
main display. If someone is located inside the room, on the main display.
Activate/Deactivate: This menu is used to activate or deactivate the motion sensor.
Setpoint temperature: This menu is used to configure the setpoint temperature to be used for temperature regulation when no one is
located inside the room.
Delay time: A delay time for the motion sensor is configured in this menu. In order to avoid temperature fluctuations in the room, the
temperature is regulated to the setpoint temperature of the motion sensor only after the delay time has elapsed.
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4.7.1.1 Activate/Deactivate
-> Sensors -> Motion sensor -> Activate/Deactivate -> Select Activate or Deactivate -> 4 x
4.7.1.2 Setpoint temperature
-> Sensors -> Motion sensor -> Setpoint temperature ->
Change setpoint temperature ->
4.7.1.3 Delay time
-> Sensors -> Motion sensor -> Delay time ->
Change delay time ->
Confirm -> 3 x

Confirm -> 3 x

4.7.2 Window sensors
i The window sensors are configured in this menu. The window sensors detect whether a window is open or closed. If the window is
open, SUNNYHEAT regulates the temperature to a specified setpoint temperature. If the window is closed, SUNNYHEAT regulates the
temperature to the normal setpoint temperature. When the window is open, appears on the main display. When the window is
closed, appears on the main display. Up to 8 window sensors can be connected to an ECOcontrol thermostat.
Activate/Deactivate: This menu is used to activate or deactivate the window sensors.
Setpoint temperature: This menu is used to configure the setpoint temperature to be used for temperature regulation when no one is
located inside the room.
Connect: This menu is used for connecting the window sensors to ECOcontrol. Up to 8 window sensors can be connected to an
ECOcontrol thermostat. Here, you can choose whether to keep or remove any already connected window sensors.
Display: The window sensors are displayed in this menu. The displayed ID corresponds to the ID on the nameplate of the respective
window sensor.
Remove: In this menu, the window sensors are removed individually.
4.7.2.1 Activate/Deactivate
-> Sensors -> Window sensors -> Activate/Deactivate -> Select Activate or Deactivate -> 4 x
4.7.2.2 Setpoint temperature
-> Sensors -> Window sensors -> Setpoint temperature ->
Change setpoint temperature ->
Confirm -> 3 x
4.7.2.3 Connect
-> Sensors -> Window sensors -> Connect ->
Remove existing window sensors or
Keep existing window sensors -> Press and
hold the button on the window sensor until the LED flashes -> Press the button on the window sensor -> ECOcontrol displays the device
as found -> Add any further window sensors ->
Confirm -> 3 x
4.7.2.4 Display
-> Sensors -> Window sensors ->
-> Display -> 4 x
4.7.2.5 Remove
-> Sensors -> Window sensors ->
-> Display -> Select window sensor -> Remove ->
Confirm -> 4 x
4.7.3 Outside temperature sensor
i The outside temperature sensors are configured in this menu. If the outside temperature sensor is activated, SUNNYHEAT only turns
up the heating if the outside temperature is below the maximum outside temperature. If the outside temperature is above the
maximum outside temperature and SUNNYHEAT is not heating up,
appears on the main display.
Activate/Deactivate: This menu is used to activate or deactivate the outside temperature sensor.
Max. outside temperature: The maximum outside temperature is configured in this menu. The maximum outside temperature is the
outside temperature up to which SUNNYHEAT normally heats. If the outside temperature is above this maximum outside temperature,
SUNNYHEAT does not heat up.
Display: The current outside temperature is displayed in this menu. If a minus is visible instead of a temperature value, ECOcontrol does
not receive a signal from the outside temperature sensor. The range should be checked.
4.7.3.1 Activate/Deactivate
-> Sensors -> Outside temp. sensor -> Activate/Deactivate -> Select Activate or Deactivate -> 4 x
4.7.3.2 Max. outside temperature
-> Sensors -> Outside temp. sensor -> Max. outside temp ->
Change max. outside temperature ->
4.7.3.3 Display
-> Sensors -> Outside temp. sensor -> Display -> 4 x

Confirm -> 3 x
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4.8 Infrared heaters
i The SUNNYHEAT infrared heaters are configured in this menu.
Connect: This menu is used for connecting the SUNNYHEAT infrared heaters to ECOcontrol. The connection process for each device can
take up to a minute, because each infrared heater is connected with a time delay to avoid data collisions. The first connected infrared
heater is marked as the master heater. The master heater is the infrared heater that controls communication with the other infrared
heaters in the group.
Display: This menu displays the SUNNYHEAT infrared heaters that are connected to ECOcontrol. The displayed ID corresponds to the ID
on the nameplate of the respective infrared heater. If several SUNNYHEAT infrared heaters are connected to an ECOcontrol thermostat,
one is in the master group and the other SUNNYHEAT infrared heaters are slaves. The master heater is always the first SUNNYHEAT
infrared heater that is connected. Which heaters are masters or slaves is not relevant for operation, but can be important for servicing.
Test: This menu makes it possible to test the range of individual SUNNYHEAT infrared heaters. If you press Test, an acoustic signal
should be audible from the infrared heater and the Send and Receive symbol should appear next to the menu. If no signal is audible
and no Receive symbol is displayed, the infrared heater is out of range.
Remove: This menu makes it possible to remove SUNNYHEAT infrared heaters individually.

4.8.1 Connect
->
-> Infrared heaters -> Connect ->
Remove existing heaters or
Keep existing heaters -> Switch off infrared heaters ->
Switch on infrared heaters with a time delay -> ECOcontrol displays the device as found ->
Confirm -> 2 x
4.8.2 Display
->
-> Infrared heaters -> Display -> 3 x
4.8.3 Test
->
-> Infrared heaters -> Display -> Select infrared heater -> Test -> 4 x
4.8.4 Remove
->
-> Infrared heaters -> Display -> Select infrared heater -> Remove ->
Confirm -> 3 x

4.9 Security
4.9.1 Child lock
i A child lock can be configured in this menu. The child lock limits the surface temperature of the SUNNYHEAT infrared heaters to a
maximum of 60.0 °C, regardless of what was entered as the maximum surface temperature. If the child Lock is activated, appears on
the main display.
Default PIN: 1000
Activate/Deactivate: This menu can be used to activate or deactivate the child lock. The child lock can only be activated or deactivated
with a PIN.
Change PIN: This menu is used for changing the PIN for the child lock.
Caution! The PIN can only be reset using the Factory settings.
4.9.1.1 Activate/Deactivate
->
-> Security -> Child lock -> Activate/Deactivate -> Select PIN ->
Change PIN ->
Confirm -> Select Activate or Deactivate
-> 4 x
4.9.1.2 Change PIN
->
-> Security -> Child lock -> Change PIN -> Select old PIN ->
Change PIN -> Select new PIN ->
Change PIN ->
Confirm -> 3 x
4.9.2 Key lock
i The key lock is configured in this menu. If the key lock is activated,
appears on the main display.
Default PIN: 1000
Activate/Deactivate: This menu can be used to activate or deactivate the key lock.
Change PIN: The PIN is changed in this menu.
Caution! The PIN for the key lock can only be reset via the factory settings.
Remove key lock: If the key lock is active, you can no longer enter the menu to remove the key lock. Therefore, users can tap the key
lock symbol to get back to the Activate/Deactivate menu.
4.9.2.1 Activate/Deactivate
->
-> Security -> Key lock -> Activate/Deactivate -> Select PIN ->
Change PIN ->
Confirm -> Select Activate or Deactivate
-> 4 x
4.9.2.2 Change PIN
->
-> Security -> Key lock -> Change PIN -> Select old PIN ->
Change PIN -> Select new PIN ->
Change PIN ->
Confirm -> 3 x
4.9.2.3 Remove key lock
-> -> Select PIN ->
Change PIN ->
Confirm -> Select Deactivate -> 4 x
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4.10 Information
i This menu provides system information about ECOcontrol and SUNNYHEAT.
Overview: The most important parameters of the master infrared heater are displayed in this menu. This menu is relevant for servicing.
About SUNNYHEAT: This menu explains who developed and produced the system.
Software version: The software version of ECOcontrol is displayed in this menu.

4.10.1 Overview
->
-> Information -> Overview ->
View values -> 3 x
4.10.2 About SUNNYHEAT
->
-> Information -> About SUNNYHEAT -> 3 x
4.10.3 Softwarev ersion
->
-> Information -> Software version -> 3 x

4.11 CREA SYSTEMS
i This menu only contains parameters for the manufacturer. The menu can and may only be used by the manufacturer with a special
PIN.

5. SUNNYHEATconnect

SUNNYHEATconnect is an app for managing the SUNNYHEAT infrared heaters. It is also a prerequisite for controlling the SUNNYHEAT
infrared heaters via the internet through apps such as the Alexa app or Amazon Echo.

5.1 Function scope
•
•
•
•
•
•
•
•

Detection of SUNNYHEAT infrared heaters and integration into the local WLAN
Registration of the SUNNYHEAT infrared heaters in the cloud for internet control via Amazon Echo, Alexa app
Control of the setpoint temperature and lighting
Display of the actual temperature, motion sensor, window sensor and battery life
Entry of a device name
Configuration of DailyPlan (heating calendar that determines when and how the heating is performed)
Restart of devices
Execution of software updates

5.2 Requirements
•
•
•
•

Android version Oreo or higher, iOS version 14 or higher
WLAN SSID and password
For internet control: Amazon login
Smart Home must be activated in the ECOcontrol thermostat

5.3 Installation

SUNNYHEATconnect is available in the Google Play store and in the Apple store. To find the app, just type in "SUNNYHEATconnect" in
the search field.

5.4 Manual

Since SUNNYHEATconnect is being continuously improved, the current user manual is available at
www.sunnyheat.com - Service - Instructions/User Manuals.
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Designed and Manufactured in Germany
by

Distributed by Sunnyheat Australia

Video Tutorials

SUNNYHEAT is a trademark of
CREA SYSTEMS Electronic GmbH
www.sunnyheat.com.au
Note: Specifications are subject to change. Always consult our website for the latest information.

